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Welcome

Welcome to the SyQuest Utilities Control Panel, a
versatile cartridge formatting and partitioning utility for
your SyQuest removable cartridge hard drive.

Using the SyQuest Utilities you can customize your drive
settings to meet your individual needs.  You can also use
the SyQuest Utilities to divide your cartridge into
separate volumes and prepare them for use on your
Macintosh.  As you use the SyQuest Utilities, your
preferences are automatically saved to ensure your drive
behaves just the way you like.

What is it?

The SyQuest Utilities provide the user interface for
selecting SyQuest drives, customizing settings and
graphically partitioning and formatting SyQuest
cartridges.  The SyQuest Utilities also include a highly
efficient, state-of-the-art device driver tuned for
maximum performance of your Macintosh computer
with attached SyQuest drives.

The SyQuest Utilities will automatically load the device
driver for your SyQuest drives when your Macintosh is



SyQuest Utilities User Manual

4

starting up (with or without a cartridge in the drive).
This device driver allows the volumes stored on your
SyQuest cartridges to come and go from the desktop as
cartridges are inserted and removed from the drive.

Major Features

q  Customization.  Use the SyQuest Utilities to
customize drive settings and optimize your drive for
specialized applications.

q  Ease of use.  The SyQuest Utilities conform to the
standard Macintosh user interface guidelines, making
them familiar and easy to use.

q  Graphical partitioning and formatting.  Use the
graphical partitioning window to simplify the process
of dividing your cartridges into multiple volumes and
preparing them for use on your Macintosh.

q  Defect repair.  Use the verify process to identify and
correct cartridge defects without needing to re-format
your cartridge.

q  Convert.  Recover space used to store hidden PC
installation files and make it available for your
Macintosh files (only available for dual format Starter
cartridges).

q  Device driver update.  There is no need to re-
initialize your existing SyQuest cartridges just to take
advantage of the latest version of the SyQuest Utilities
device driver.  You can use the SyQuest Utilities to
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update your device drivers without affecting the data
stored on your cartridge.

System Requirements

The SyQuest Utilities are fully compatible with System
7.0 and above running on 68020 and PowerPC based
Macintosh computers.

In addition, the SyQuest Utilities can be used with
Apple’s Classic SCSI manager or SCSI Manager 4.3.

The SyQuest Utilities will initialize and recognize
cartridges in the HFS Standard and HFS Extended (when
running Mac OS 8.1 and above) volume formats.

Assumptions

This manual assumes you are familiar with the operation
of your Macintosh computer.  This includes use of the
mouse, selecting items from pull-down and pop-up
menus.  If you require additional information on any of
these features, refer to the Getting Started guide that
came with your computer.

In addition, it may help if you are familiar with
commonly used hard disk terminology.  In this manual
these terms appear in bold italic.  The glossary at the end
of this document defines these terms if you are not
familiar with them.
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Installation
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The Package

How you obtained the SyQuest Utilities determines
where you will find the following components.  If you
received the software when you purchased your SyQuest
drive, the following components are located on the
cartridge that came with your drive.

If you downloaded the software from the SyQuest web
site, then these components are included in the archive
you downloaded.  Extract them to a folder on your hard
disk prior to starting the installation.

In either case, you should have:

q  The SyQuest Installer.  This component contains the
SyQuest Utilities Control Panel.  The installer will
automatically copy the SyQuest Utilities to the
“Control Panels” folder.  In addition, if previous
versions of Silverlining  or SCSI Probe are active in
the “Control Panels” folder, these items are moved to
the “Control Panels (Disabled)” folder.

q  The User Manual.  An electronic copy of this manual
is included in PDF format (this file).  A PDF viewer
(e.g., Adobe Acrobat  Reader) must be installed on
your computer to view the manual.
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q  The Read Me File.  A Simple Text file that contains
last minute product updates and Frequently Asked
Questions.  Be sure to read this file before installing
the software.

Installing the SyQuest Utilities

The SyQuest Installer is a compressed archive containing
the SyQuest Utilities software.  Using the installer
simplifies installing and uninstalling the SyQuest
Utilities.  The following sections describe installing from
a cartridge, a floppy disk or the Internet.

NOTE: To prevent conflicts during the installation
process, it is recommended that you start your computer
with system extensions disabled.  To disable extensions,
hold down the shift key as your computer is starting up.

Preparing to Install from a Cartridge

If you have just purchased a SyQuest drive, a cartridge
was included with your drive.  This cartridge contains
the SyQuest Installer.  You may install the SyQuest
Utilities directly from your cartridge using the following
steps:

1. Connect your SyQuest drive to your computer as
directed in the installation documentation that came
with your drive.

2. Power on your drive and firmly insert the included
cartridge, pressing in and down on the cartridge tab
until it clicks into place.  Wait for the drive to become
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ready.   For more information on this process, refer to
the installation documentation or SyQuest User
Guide.

When the drive is ready, power on your computer.  From
the Finder, locate the cartridge on the desktop and
double click it to open the installation folder.

Preparing to Install from a Floppy

From the Finder, insert the SyQuest Utilities installation
diskette.  A floppy disk icon should appear on the
desktop.  Double click it to open the installation folder.

Preparing to Install from the Web Site

Create a folder on your hard drive to store the SyQuest
installation files.  Access the SyQuest web site at
http://www.syquest.com and download the SyQuest
Utilities archive to that folder.  Use a decompression
program (e.g., Stuffit) to extract the files from the archive
in to the current folder.  From the Finder, locate and open
the SyQuest Utilities folder.

Installing the SyQuest Utilities

To install the new utility software, simply double-click
on the “SyQuest Installer” located in the installation
folder.

The Welcome dialog box presented by the installer
contains a brief introduction to the SyQuest Utilities and
a list of files included with the software.
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The contents of the dialog box may be printed or saved
(although a simple text Read Me document containing all
of this information and more is provided in the
installation directory).  To continue with the installation,
click Continue.  To exit the installer without modifying
your system, click Cancel.

The next dialog box contains the SyQuest Software
License Agreement.
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You must agree to the terms of this agreement to install
the software.  Click Agree to continue the installation.
Click Disagree to exit the installer without modifying
your system.

The following dialog box will start the installation
process.
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NOTE:  The SyQuest Utilities are stored in the Control
Panels folder.

This screen also identifies the amount of hard disk space
that will be used by the software.  Click Install to proceed
with the installation.

After clicking Install, you will be notified that your
system may need to be restarted after the installation is
complete for the changes to take effect.

If there are other applications running, click No to exit
the installer and exit these programs.  When you are
ready to proceed, click Yes to continue.

NOTE: If a version of Silverlining or SCSI Probe is active
in the “Control Panels” folder, it will be moved to the
“Control Panels (Disabled)” folder on your system.
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The Basics
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At A Glance

The SyQuest Utilities were designed with the novice user
in mind. The most common features are always at your
fingertips.  Most users will be able to start the SyQuest
Utilities and quickly accomplish tasks without using any
menu options.

The Main Window
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The key features of the main window will be presented
first.  After you are comfortable with the layout of the
SyQuest Utilities, skip to the section of the manual that
describes the functions you wish to perform.

Most of the functionality of the SyQuest Utilities is
confined to this single window.  This window appears
when you first start the SyQuest Utilities and remains as
long as the utility is running.  The window is divided
into two main sections: a device selection list and a
tabbed list of actions that can be taken for the selected
drive.  Each user interface feature is presented below
with a picture and a description of its function.

The Help Button

The help button (located in the lower left corner of the
SyQuest Utilities window) turns on and off Balloon help.
Balloon help provides online help for most elements of
the user interface.  With Balloon help active, you can
point at any item of interest and view a detailed
description of the feature.  When done, click the help
button again to turn off Balloon help.
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A sample balloon describing the “Cache Reads” attribute
is shown above.

The Drive Selection List

The Drive Selection List on the left side of the SyQuest
Utilities window lists all the SCSI and ATA busses and
their attached devices. Each entry in the list corresponds
to a SCSI or ATA device.  The information presented
includes an icon representing the device, the device
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identifier (or Device ID) and the manufacturer
information for the device.

You can use the triangles to the left of an entry to show
or hide additional information about the item.  For
instance, if you are not concerned about the devices on
Bus 0, you can click once on the triangle next to bus 0 and
those items will no longer be visible.

You can also click the triangle of a closed entry to display
additional information.  For example, to display the
volumes mounted for any SyQuest cartridge, click the
triangle next to any drive.  The volume name, space used
and available space are displayed for each mounted
volume.

NOTE: By dragging the lower right corner of the
window, you can stretch the window to display more
information about the volumes in the list (as shown
below).
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Device Information

The right half of the window displays information about
the selected SyQuest device.  This includes information
specific to the drive, the inserted cartridge and expert
settings that control the SyQuest Utilities device driver.
By clicking the appropriate tab, the indicated information
is displayed.

NOTE: The tabs are functional only when a SyQuest
drive is highlighted in the Drive Selection List.

The Drive Tab

This section contains drive-specific features and
information.  The Drive panel becomes visible when the
Drive tab is selected.  Changes made while in the Drive
panel are saved either by the drive itself or in the
SyQuest Utilities’ preference file.  Since these options are
specific to the drive, they are in effect for any cartridge
inserted into the drive.

The Cartridge Tab

This section contains cartridge-specific features and
information.  The Cartridge panel becomes visible when
the Cartridge tab is selected.  Changes made while in the
Cartridge panel are saved to the cartridge and are
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automatically in effect each time that specific cartridge is
inserted into the drive.

The Expert Tab

This section contains options for the advanced user.
Typically, these options are used to control the
performance and fundamental cartridge-handling
characteristics of the drive.  The Expert panel becomes
visible when the Expert tab is selected.  The Expert panel
settings are stored in the SyQuest Utilities’ preference
file.  Since these options are specific to the drive, they are
in effect for each cartridge inserted into the drive.

Other Features

The remaining features of the main window, including
the “Rescan”, “Unmount”, and “Use Defaults” buttons
are discussed in detail in The Interface chapter.

Quick Start

If you have previously used another software product to
manage your SyQuest cartridges, it is recommended that
you make a backup of that data before using these
cartridges with the SyQuest Utilities.

Refer to the manuals shipped with your system for
information about how to back-up your files and how to
restore them in the event of a problem.
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IMPORTANT

Before continuing, make sure that each SCSI device on a
bus has been assigned a unique SCSI ID.  See the
documentation that came with your SCSI devices to
determine how to set the SCSI IDs for your devices.

It is also important to properly terminate the SCSI chain.
You must have a terminator at the beginning and at the
end of the SCSI chain.  See your Macintosh or SyQuest
drive User Guide if you require additional information.

Starting the SyQuest Utilities

To use the SyQuest Utilities, they must be installed on
your hard drive as described in the Installation chapter of
this manual.

To start the utility program, select Control Panels from
the Apple menu.  From the Control Panels folder, locate
and select the SyQuest Utilities.

This section will help you quickly prepare your
cartridges for use with your Macintosh.  To begin, locate
and select the SyQuest drive you want to work with in
the Drive Selection List.  If you are unable to locate your
SyQuest drive, please refer to the Frequently Asked
Questions section of the Read Me file.

NOTE:  You will not be able to prepare this cartridge if it
contains the startup volume, open files or running
applications, is locked, is password protected (using a
third party utility), or is shared via FileSharing.
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Select the Cartridge tab and follow the instructions in the
following sections to prepare your cartridge for use by
the Macintosh.

Updating Existing Cartridges

Although we recommend using the latest SyQuest device
drivers to obtain the maximum performance from your
SyQuest products, it is not necessary for you to update
the device driver in order to use your cartridge.

If you choose not to update your device drivers, we
recommend starting your computer with the SyQuest
drive powered on, but no cartridge inserted in the drive.
Only insert a cartridge after your computer has started
(i.e. the Finder’s menu bar has appeared on your screen).

WARNING:  It is recommended that you have a current
backup of your cartridge before proceeding with the
device driver update.  Although great effort was
expended to ensure that you can update your cartridge
without data loss, software errors can occur that may
result in the destruction of data on your cartridge.

To update the device driver while preserving the existing
files on your cartridge, follow these steps:

With the Cartridge panel selected, press the Option key
to display the Update button.  This button will appear in
the Prepare section of the panel.  While holding the
Option key, click the Update button to start the
operation.
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This procedure will close any existing device driver
currently accessing your SyQuest cartridge and replace it
with the new SyQuest Utilities device driver.

If you have additional cartridges to update, you can use
the Unmount button below the Drive Selection List to
eject the current cartridge, and insert another.

Preparing New Cartridges

To use new cartridges (or erase data from existing
cartridges), you must prepare them for use.  There are
two ways to prepare your cartridge: format and initialize.
Both are available by clicking Prepare on the Cartridge
panel.
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The Format/Initialize This Disk screen offers three
functions: partition, format and initialize.  Each is briefly
described in the following section.

Partitioning

Whether formatting or initializing, the SyQuest Utilities
enable you to create multiple partitions.  Partitions are
the computer’s way of dividing a large capacity cartridge
into smaller sections, each appearing as a separate
volume.  Partitioning makes it possible to have more
than one operating system on a single cartridge or to
divide a cartridge that is too large to be a single volume
into smaller pieces.  Up to eight partitions can be created
on a cartridge, although a typical user will prepare their
cartridge using a single partition (which is the default for
the dialog box).



SyQuest Utilities User Manual

27

By default, the total space available on the cartridge is
divided evenly between the selected number of
partitions.  If you would like to modify this arrangement,
click any partition in the pie (its color will darken to
indicate it is now selected).

Once a partition is selected, the size may be modified by
grabbing and dragging the square black handle at the
edge of the pie, or by typing a new value in the Size field.

NOTE:  If a value larger than the free space remaining on
the cartridge is entered, the SyQuest Utilities will
automatically set the value equal to the free space
available for the cartridge.

Each partition on the cartridge has a name that the Finder
uses when displaying the volume on the desktop.  By
default, the name ‘Untitled’ and the partition number
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will be used (e.g., ‘Untitled #1’) to identify the volume.  If
a name is not provided, the SyQuest Utilities will create a
name using the cartridge type and capacity (e.g., SyJet 1.5
GB).

Like the size, a different volume type can be specified for
each partition. The SyQuest Utilities can prepare the
volume using either the Mac OS Standard or Mac OS
Extended volume format.  This selection is made using
the Volume Type pop-up.

NOTE:  A Mac OS Extended partition can only be
created and recognized on systems running Mac OS 8.1
or later.

Formatting

Formatting a cartridge organizes its internal structures to
accommodate data storage of any kind.  All cartridges
need to be formatted, but most are formatted at the
factory.  You will probably never need to format any of
your cartridges; however, there are two advantages to
doing so.

q  Secure Erase.  All data on the cartridge is completely
erased and can never be recovered.  If you have
sensitive files on your cartridge that you want to
erase, there is no more secure way to do that than a
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low level format.  Unfortunately, formatting is not
selective.  You cannot choose which files to erase; the
entire cartridge is erased.

q  Correcting cartridge flaws.  During the course of a
format, the cartridge is scrutinized carefully by your
drive.  Any defects found on the cartridge are
repaired.  If you have reason to believe that there are
bad sections on your cartridge that should be
repaired, the best way to proceed may be a format
operation.

WARNING:  Format is an irreversible action that should
only be performed if the data on the cartridge has been
backed up.

The time required to format a cartridge will vary based
on the capacity of the cartridge.  The following chart may
be useful to estimate the time required.  The times listed
are approximate, and may vary.

Cartridge Type
and Capacity

Duration
(hours:minutes)

SQ400 44 MB 0:03
SQ800 88 MB 0:05
SQ2000 200 MB 0:04
SQ3270 270 MB 0:05
EZFlyer 135 MB 0:05
EZFlyer 230 MB 0:07
SyJet 1.5 GB 0:20

To start formatting the cartridge, click the Format button.
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Initializing

Although this process also erases the files on your
cartridge, it does not perform the elaborate cartridge scan
and problem detection done by a format operation.
However, since it is less complex, it completes much
more quickly than a format.

WARNING:  Initialize is an irreversible action that
should only be performed if the data on the cartridge has
been backed up.

To start initializing the cartridge, click the Initialize
button.

The Status Window

After clicking the Initialize or Format button and
confirming that the operation will destroy any data
stored on the cartridge, the status window is displayed.
It will remain on the screen until the operation is
complete and the new volumes are ready for use.

NOTE:  On some older Macintosh computers, the
animated barber pole may not be present.  This is an



SyQuest Utilities User Manual

31

indication that your computer cannot be used to perform
other operations until the current process is complete.
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The Interface
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A Guided Tour

The following sections contain a detailed discussion of
the options available in the SyQuest Utilities.  Refer to
this section to quickly find information about a function
that interests you.

 The Menu Bar

After starting the SyQuest Utilities, a menu bar is present
at the top of the screen.  The menus provide an alternate
method of accessing the utility features or access to
infrequently used options.

As with other Macintosh applications, short cuts can be
used to access some menu items using the keyboard.  If
an item has a keyboard shortcut, it will be listed to the
right of the item on the menu.

The Apple Menu

The Apple menu contains any desk accessories that you
currently have installed in your System folder.  The
Control Panels folder is available from the Apple menu.
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In addition, when the SyQuest Utilities are running, the
first item on the Apple menu will provide information
about the software.  If you ever need to determine the
version number of the software, it can be found in the
About dialog box.

The File Menu

The File menu provides options to manage application
data and quit the program.  A detailed description of the
menu items is provided below.
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q  Close.  This item closes the topmost opened window.

q  Save Settings.  This item saves any changes to any
settings you make from within the application.  The
save operation may update data in the preference file,
on the drive, or on the cartridge.

q  Revert.  This item restores all settings to their
previously saved state.  It can be used to undo
accidental modification of settings.  This option is not
the same as the “Use Defaults” button that appears in
the interface.  More information will be provided on
the utility defaults in a later section.

q  Quit.  This item allows you to quit the SyQuest
Utilities and return to the Finder.

The Edit Menu

The Edit menu offers the standard editing commands.
These standard editing items are not used by the SyQuest
Utilities, but may be used by a desk accessory.
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The Windows

This section of the documentation takes you through
each of the SyQuest Utilities functions, explaining each of
the user interface elements and their uses.

The Main Window
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Use this section of the manual as a reference; skip to the
section that describes the functions you wish to perform.
Remember, while in the utility, you can always click the
help button to view a description of the feature pointed
to by the mouse.

A sample balloon describing the “Cache Reads” attribute
is shown above.
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The Drive Selection Area

The Drive Selection List

The Drive Selection List fills the majority of the drive
selection area.  It lists all the SCSI and ATA busses in the
system and their attached devices.  The information
presented includes an icon representing the device, the
device identifier (or Device ID) and the manufacturer
information for the device.

You can use the triangles to the left of an entry to show
or hide additional information about the item.  For
instance, if you are not concerned about the devices on
Bus 0, you can click once on the triangle next to bus 0 and
those items will no longer be visible.
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NOTE: Only SyQuest devices may be selected from the
list.  The rest of the user interface is unavailable until a
SyQuest drive is selected.

The Rescan Button

If a device does not automatically show up in the list
when the utility is started, it may not be connected,
powered on or properly configured.  To resolve the
problem, verify that the SyQuest drive is properly
configured, connected to your Macintosh and powered
on.  For additional information, please refer to the
Frequently Asked Questions section of the Read Me file,
or the installation documentation that came with your
SyQuest drive.  After correcting the problem, you can
click the "Rescan" button to refresh the list.

WARNING: You should never attach or remove a device
from the computer while it is powered on.  Doing so may
result in damage to your computer or your SyQuest
drive.

The Mount/Unmount Button

This button is located in the lower right corner of the
drive selection area.  If a selected drive has volumes that
are not displayed on the desktop, the button will read
Mount.  Click the Mount button to display these
additional volumes on the desktop.

The button will read Unmount when either volumes
stored on the selected drive are present on the desktop or
when a volume is selected.
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To remove a specific volume from the desktop, click on
the triangle next to the drive to display the volume list.
Select the volume to be removed, and click the Unmount
button.  If only one volume was displayed in this list, the
cartridge will be ejected from the drive (if possible).

NOTE: Some older SyQuest drives (e.g., SQ5110, SQ5200,
etc.) did not offer an automatic method for ejecting
cartridges.  These drives require an eject button to be
pressed and an eject lever to be used to remove the
cartridge from the drive.

To remove all volumes associated with the selected drive
from the desktop and eject the cartridge (if possible),
select the drive and click the Unmount button.

NOTE: If after selecting a drive, the button still reads
Mount, not all of the volumes for the drive are currently
mounted.  To continue to Unmount the cartridge, press
and hold the Option key.  The button will change to read
Unmount; click it to eject the cartridge from the drive (if
possible).
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The Drive Panel

Each item on this panel represents a feature of the drive.
If a drive is not selected in the drive list, this panel is
disabled and cannot be selected.  The Drive panel is
divided into the following four sections.

NOTE: The features available will vary by drive model.
Saving drive settings may require a cartridge to be
inserted in the drive.  If the options on this panel are
unavailable even after selecting a drive, verify that a
cartridge is properly inserted in the drive.
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Drive Information

The drive information section identifies the drive model
(e.g., SyJet 1.5 GB), the type of interface used by the drive
(e.g., SCSI) and the name and version number of the
device driver that is managing the drive.  This
information may be requested when communicating
with SyQuest Technical Assistance.

Power Management

Some SyQuest drives offer an option to allow the drive to
sleep when it is not used for a specified period of time.
Power saving is enabled when the Drive Sleeps box is
checked.  Power Save is enabled by default, to reduce
noise, energy consumption and wear-and-tear on the
drive.  The available sleep times will vary by drive
model.

NOTE: The first access to a drive which has gone to sleep
will take several seconds to complete.  To prevent a drive
from going to sleep, verify that the Drive Sleeps box is
not checked.
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Drive Attributes

This section identifies which drive attributes are
currently enabled. In addition, an attribute may be
modified by checking or unchecking the specific option.
If changing an option could adversely affect drive
performance, a warning is displayed.  A detailed
description of each attribute is presented below.

q  Cache Reads.  When checked, the drive will attempt
to make frequently accessed information available to
the operating system without having to re-read it
from the cartridge.  This option substantially
improves read performance of the drive.  The default
for this option is checked.

q  Cache Writes.  When checked, the drive may indicate
to the operating system that the data has been written
to the cartridge before it has actually completed the
operation.  Doing so allows the computer to continue
to perform other operations while the drive actually
saves the data to the cartridge.  While this option can
result in performance gains, rare problems writing
data to the cartridge could result in data loss.  The
default setting for this option is unchecked.

q  Locked.  When checked, the drive will not permit
changes to any cartridge inserted in the selected
drive.  To prevent this cartridge from being modified
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in any drive, see the Locked attribute on the Cartridge
tab.  The default setting for this option is unchecked.

q  Audible Eject.  When checked, the drive will beep
once when preparing to eject the cartridge and may
also beep three times after the cartridge is ejected.
The default setting for this option is checked.

Firmware Information

The current firmware revision used by the drive is
displayed in this section.  This information may be
requested when communicating with SyQuest Technical
Assistance.

Drive Panel Defaults

If you have made modifications to the settings on the
Drive panel and wish to revert to the factory default
settings, click the Use Defaults button.

NOTE:  To revert to the previously saved settings (not
necessarily the default settings), use the Revert option on
the File menu.
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The Cartridge Panel

Each item on this panel represents a feature of the
currently inserted cartridge.  If a drive is not selected in
the drive list or a cartridge is not inserted in the drive,
this panel is disabled and cannot be selected.  The
Cartridge panel is divided into the following four
sections.

NOTE: The features available will vary by drive model.
If the options on this panel are unavailable even after
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selecting a drive, verify that a cartridge is properly
inserted in the drive and the cartridge is not locked.

Cartridge Information

The cartridge information section identifies the cartridge
type (e.g., SyJet), capacity (e.g., 1.5 GB) and the factory
assigned serial number for the cartridge.  If a serial
number was not assigned to the cartridge, the text ‘No
Serial Number’ will appear.  This information may be
requested when communicating with SyQuest Technical
Assistance.

Cartridge Attributes

This section identifies which cartridge attributes are
currently enabled.  In addition, the attribute may be
modified by checking or unchecking the specific option.
If changing an option could adversely affect drive
performance, a warning is displayed.  A detailed
description of each attribute is presented below.

q  Removable.  When checked, the cartridge in the
selected drive is treated as removable media.  When
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the cartridge is removable, it may be ejected from the
drive.

When unchecked, the cartridge in the selected drive is
treated as a fixed hard disk.  In this case the cartridge
cannot be removed from the drive.  If the volume is
dragged to the trash, it will disappear from the
desktop (until the machine is restarted), but not eject
from the drive.

If you wish to eject the cartridge, the Removable box
must be checked.  The default for this option is
checked.

q  Verify Writes.  When checked, data written to the
cartridge is validated against the original data before
the write command is considered successful.  This
option offers protection against data loss.  Although it
can affect drive performance, it is recommeneded that
you do not disable this function.  The default for this
option is checked.

q  Locked.  When checked, the drive will not permit
changes to the cartridge.  Since this is an attribute of
the cartridge, it will automatically be applied to this
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cartridge in any compatible drive.  The default for this
option is unchecked.

NOTE:  The cartridge options are automatically
disabled, if the cartridge inserted in the drive is
locked.  To modify the cartridge options, uncheck the
Locked attribute and save the cartridge settings.

q  AV Playback.  When checked, the drive will disable
some error handling options, in an effort to improve
drive performance.  The default setting for this option
is unchecked.

WARNING: This option should only be used to
playback audio/visual data from the drive at a more
consistent rate.  Enabling this option may result in
data errors being ignored by the drive.  This option
should not be checked when writing data to the
cartridge.

Error Handling

SyQuest drives will automatically correct most cartridge
errors encountered during the normal use of the drive.
The following options allow you to fine tune the way the
drive handles problems reading or writing to the
cartridge.  If changing an option could adversely affect
drive performance, a warning is displayed.  A detailed
description of each option is presented below.
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q  Fix on Read.  When checked, the drive will
automatically relocate data to another location on the
cartridge when there is a correctable error reading
data from the cartridge.  The default for this option is
checked.

q  Fix on Write.  When checked, the drive will
automatically relocate data to another location on the
cartridge when there is a correctable error writing
data to the cartridge.  The default for this option is
checked.

q  Software ECC.  When checked, the drive will attempt
to correct errors reading and writing from the
cartridge using a mathematical formula and an error
correction code (ECC) that is stored with the data.  If
the error can be corrected the data can be successfully
read or written.  If this option is unchecked, the same
error would cause the operation to fail, and partial or
incorrect data to be used.  The default setting for this
option is checked.

Convert Partition

Some SyQuest cartridges are prepared using a special
dual format.  A dual format cartridge contains Macintosh
and PC files.  If the cartridge won’t ever be used on a PC
computer, the space allocated for these files can be
reused.  The Convert button will appear in the Prepare
section of the Cartridge tab only when a dual format
cartridge is present in the selected drive.
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Clicking the Convert button will display the Convert
dialog box.  This dialog box offers two options for
recovering the space used by the hidden PC files.

q  Erase the hidden PC files and make a single
Macintosh partition.  The first option will combine
the space used by the existing Macintosh volume
with the space used by the PC files to form a single
large volume.

q  Erase the hidden PC files and make multiple
Macintosh partitions.  The second option will
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convert the space used by the PC files into a new
Macintosh volume.

In either case, the files stored on the existing Macintosh
volume are not affected by the operation and the PC files
are always erased.

WARNING:  It is not possible to backup the PC portion
of the cartridge using your Macintosh computer or to
recreate the dual format cartridge once it has been
recovered.

NOTE:  Depending on the version of the Mac OS your
computer is running, combining the Macintosh and PC
volumes may exceed the largest volume size understood
by the operating system.  In this event, the “Erase the
hidden PC files and make a single Macintosh partition”
option will not be available.

Cartridge Verify

Over time cartridges can develop minor imperfections
that may prevent reliable access to data stored in that
location.  Generally, the drive will detect these conditions
before they become catastrophic and automatically move
the data to a safer location.  However, the drive will only
perform this correction when it encounters a problem,
during the normal use of the cartridge.  If you wish to
identify and correct all such problems anywhere on the
cartridge, you need to scan the entire cartridge.
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The Verify option on the Cartridge panel offers four
methods of identifying and correcting problems with a
cartridge.

q  Light.  Light verification performs the fewest checks
on the cartridge, but operates the fastest.  If a quick
check is all that is required (or time permits), this
option should be used.  It will attempt to verify each
location on the cartridge and automatically fix any
problems encountered.  The data stored on the
cartridge is not affected by this operation.

q  Medium.  Medium verification performs more checks
of the cartridge, and requires more time.  A Medium
Verify will attempt to read each location on the
cartridge.  This time, the drive is responsible for
correcting problems encountered during the
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operation.  The data stored on the cartridge is not
affected by this operation.

q  Heavy.  Heavy verification performs even more
checks of the cartridge and requires more time.  A
Heavy Verify will attempt to read and write each
location on the cartridge using a single pattern.  The
pattern used may cause marginal areas of the
cartridge to fail, where previous verification methods
would not have detected problems.  When a Heavy
Verify is used, the SyQuest Utilities are responsible
for correcting errors encountered on the cartridge
(bypassing the drive’s built-in support for this
function).  Doing so allows a marginal area of the
cartridge to be identified and its data relocated.  The
data stored on the cartridge is not affected by this
operation.

q  Full.  Full verification performs the most complex
scan of the cartridge.  It will require the most time to
complete and is generally used only as a last-ditch
effort to salvage an unreadable cartridge.  A full
verification will reset the defect list for the cartridge
to its factory default state and use six different
patterns in an attempt to identify problem areas on
the cartridge.  The partitions and data stored on the
cartridge are erased by this operation.

NOTE: When a full verify completes, or is cancelled,
the cartridge is ejected from the drive (if possible).   It
is important to format the cartridge before it is used
again (even if the full verify was stopped before it
was complete).
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Once a verification method is selected, and the process is
started, the verification status window is displayed.  This
window provides a gauge of the progress, time
remaining and number of problems encountered.

NOTE:  The Verify operation can be stopped using the
Cancel button in the status window.  It can take several
seconds after clicking the Cancel button to terminate the
Verify operation.

Cartridge Panel Defaults

If you have made modifications to the settings on the
Cartridge panel and wish to revert to the factory default
settings, click the Use Defaults button.

NOTE:  To revert to the previously saved settings (not
necessarily the default settings), use the Revert option on
the File menu.
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The Expert Panel

Each item on this panel specifies how the SyQuest
Utilities device driver interacts with the selected drive.
The settings on this panel will affect every cartridge
inserted into the drive.  If a drive is not selected in the
drive list, this panel is disabled and cannot be selected.
The Expert panel is divided into two sections.
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Eject Options

This section identifies under what circumstances the
cartridge will be ejected from the drive and how the
device driver reacts when the cartridge is ejected.

q  Eject Cartridge at Restart.  When checked and your
Macintosh computer is restarted, any cartridge
inserted in the selected drive will be removed from
the desktop and if supported, ejected from the drive.
The default for this option is unchecked.

q  Eject Cartridge at Shutdown.  When checked and
your Macintosh computer is shutdown, any cartridge
inserted in the selected drive will be removed from
the desktop and if supported, ejected from the drive.
The default for this option is checked.

q  Close Driver when Ejected.  When checked and a
cartridge is ejected from the drive, the SyQuest
Utilities will unload support for the selected drive.
The next cartridge inserted in the drive will not
automatically be supported by the SyQuest Utilities.
The Mount button in the drive selection area must be
used to load support for cartridges inserted into the
selected drive.  The default for this option is
unchecked.
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Miscellaneous Options

This section contains the miscellaneous SyQuest Utilities
device driver options.

q  Do not Support Drive at Startup.  When checked, the
SyQuest Utilities device driver will not load support
for the selected drive.  This option should be checked
if you would like to prepare and control your
SyQuest drive using a different application.  The
default for this option is unchecked.

q  Do not Mount Cartridge at Insertion.  When
checked, the SyQuest Utilities will not periodically
check if a new cartridge is inserted into the selected
drive.  This periodic polling of the drive could affect
drive performance if it is being used to stream audio
or video information from a cartridge.  The default for
this option is unchecked.

q  Disable Synchronous Negotiation.  When checked, a
faster method of transferring data (synchronous
transfers) will be disabled.  This may be necessary for
older SyQuest drives which did not properly support
synchronous requests.  This option should only be
checked on the advice of SyQuest Technical
Assistance.  The default for this option is unchecked.
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Expert Panel Defaults

If you have made modifications to the settings on the
Expert panel and wish to revert to the factory default
settings, click the Use Defaults button.

NOTE:  To revert to the previously saved settings (not
necessarily the default settings), use the Revert option on
the File menu.
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Glossary
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Asynchronous Transfer.  A method of sending or
receiving data to/from a device.  The computer can
continue performing other actions while the device (e.g.,
disk drive) processes the original request.

Backup.  To safeguard information by copying it to an
alternate location.  A duplicate copy of data stored on a
cartridge.

Correctable Error.  A data error, which through the use
of a mathematical formula, can be fixed.  The operating
system or application may be unaware of a problem.

Defect List.  A list of marginal or failed areas of the
cartridge that is maintained by the drive.  Each time the
drive is unable to read or write a portion of the cartridge,
the location is added to the defect list and will not be
used to store data.

Device Driver.  The system software, which
communicates with a piece of hardware such as your
SyQuest drive.

Device Identifier.  A unique identifier assigned to each
device in a SCSI chain.  For narrow SCSI busses, the
number can range from 0 to 7.  For wide SCSI busses, the
number can range from 0 to 15.

Dual Format.  A specially constructed SyQuest cartridge
that contains both Macintosh and PC files.  While using
the cartridge on a Macintosh computer, only the
Macintosh files are visible.  Similarly, the Macintosh files
are not visible when the cartridge is used on a PC.
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Error Correction Code (ECC).  Additional information
stored with each block of data on the cartridge that can
be used to automatically correct errors reading or writing
the cartridge.

Firmware.  The software inside a piece of hardware,
which controls the operations of the device.  Some
devices support updating this software, while others
cannot be modified.

Formatting.  The process of preparing a cartridge for use
by your computer.  The drive divides the disk into
sections, identifies, and if possible, corrects potential
problem areas of the cartridge.

Partitioning.  A method of dividing a cartridge into
multiple pieces, each which can be formatted and store
data.  Each partition in the system typically appears as a
separate volume.

Removable Device.  A storage device that allows its
media to be ejected and replaced (e.g., floppy disk drive,
CD-ROM drive, cartridge hard drive, etc.).

SCSI.  Small Computer System Interface.  A method for
connecting and communicating with hardware that
conforms to the SCSI specification.

SCSI Chain.  The set of SCSI devices connected together
with short cables is collectively called a SCSI bus or
chain.
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Synchronous Transfer.  A method of sending or
receiving data to/from a device.  The computer must
wait for the operation to complete before performing
other actions.

Terminate.  To identify the end of a SCSI bus by
attaching a resistor pack (i.e., terminator).  Each end of
the SCSI bus must be explicitly identified or problems
using the SCSI devices may occur.
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